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CHAPTER 1 — INTRODUCTION TO
OUTLOOK INTEGRATION

The Outlook Integration Tool for use with InEight Document is a plug-in that enables users to view,
send, and receive their InEight Document mail and Transmittals from within MS Outlook, rather than
having to login to InEight Document. All actions relating to InEight Document mail/transmittals
performed within MS Outlook are then stored back in the InEight Document system automatically.

Features Benefits

Access to the complete correspondence and
transmittal message history of a project with all
InEight Document formatting, custom fields and
attributes including Reference Number,
Discipline and Status retained.

Eliminates the need to use two different
systems. The user automatically inherits a
personal archive of all sent and received
InEight Document project mail, segregated
into separate projects in Outlook

Use of Outlook to create, send, and receive
InEight Document mail and transmittals.

Familiarity with Outlook minimises need for
additional training.

Complete status management.
Encourages the use of InEight Document
project correspondence to be expedited and
closed-out.

Offline capability. InEight Document mail is
automatically downloaded into dedicated
folders in Outlook.

Ability to read project correspondence offline
and draft responses.

All overdue items highlighted in red for ease of
identification

Quickly identify correspondence for which
response is overdue
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CHAPTER 2 — INSTALLING OUTLOOK
INTEGRATION
1. Close Microsoft Outlook, if it is already open.

2. Download the installation package using one of the following links:

l Download 32-bit version of Microsoft Outlook

l Download 64-bit version of Microsoft Outlook

If you are unsure which version of Microsoft Outlook you are using, within Outlook select:
File »Help »About Microsoft Outlook. For Office365 Users select File »Office Account
»About Outlook

See also:

Outlook Integration Video

2.1 PRE-REQUISITES

l Windows (any)

l Outlook 2003 Onwards

l Dot Net Framework V 4.0
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2.2 INSTALLATION STEPS

1. Once the download is complete, unzip the zip files.

2. Double click and run setup.exe from the extracted files.
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3. Select a folder location for file installation. Select “Just Me” for yourself or “Everyone” in order
to install for all who use the computer.
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4. Click Next.
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5. Select Default Installation then click Next.

The default Installation installs Outlook Integration with pre-defined
settings. Custom Installation allows you to choose you own settings when installing
Outlook Integration.
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6. Click Install to begin installation.
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7. Once installation has completed, click Finish.

2.3 CUSTOM INSTALLATION SETTINGS

If Custom Installation is selected at step 5 in section 2.2 above then the window below will appear,
allowing you to apply your custom installation settings. This allows you to specify additional settings
especially if your corporate policies do not allow your outlook Data file to be stored in the default
location or if specific proxy settings are required.
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1. Add Proxy information if required to connect to the internet. This will be pre-configured for all
users of this InEight Document Outlook Integration instance.

2. Select the appropriate Data store location:

l Default: Data gets stored in the user’s local application data folder.

l Roaming: Data is stored in the user’s roaming application data folder.

l Custom: Used to specify a custom location. Although the network location drives can be
specified, InEight does not recommend this as it leads to data corruption issues.

3. “Enable auto update” is selected by default. By deselecting this option auto update will be set to
“Never” and the Outlook Integration user will not be able to change this setting.

4. “Show Manage Projects screen when Outlook starts” is selected by default. When deselected it
will not show the manage projects screen when Outlook starts.
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CHAPTER 3 — CONNECTING TO INEIGHT
DOCUMENT FROM OUTLOOK

When starting Outlook for the first time after installation of the plug-in, you are prompted to identify
which InEight Document Server/Projects you want to connect to.

If you are not prompted, click the Teambinder Tab and select “Manage Projects.”

1. Click the Add button to connect one or more InEight Document projects to Outlook.

2. At the Login window select the appropriate server that your project is located on. This is the URL
shown once logged into InEight Document. If you are unsure of the server details, contact the
InEight Document Support Hotline.

3. Log in by entering your InEight Document User ID, Company ID & Password or Company Login
then clicking Login. A list of the InEight Document Projects you have access to will then be
displayed.
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4. Select the Project(s) to synchronise with Outlook Integration.

5. Tick Get All Mail to download existing InEight Document Mail.

Warning: As this process could take a long time if you enter a very early date, entering a

date less than a month ago in the Download mail/Sent/Received Since column is recommended.

6. Click OK to confirm the selected projects.
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7. If Two Factor Authentication is enabled for the InEight Document account being added, Outlook
Integration will prompt you to enter the ‘Two Factor Authentication token’ generated in your
Authenticator App in your mobile device.

l To use a company login rather than your personal user login, at Step 3
above click on the Company Login (Single Sign-on) tab. The Company
Login requires the email address linked to your InEight Document
Account and is only available if InEight Document Single Sign-On is pre-
configured for your company by InEight. Please contact your InEight
Document account manager or Project Delivery Consultant for more
information on this.

l Use the Change button to change the user that is currently logged into
the same project. Then enter new login details.

l To limit the size of attachments downloaded into Outlook from InEight
Document before adding a project, click the Settings button and select
the General then adjust the size limit for file attachments against the
option Download mail or transmittal attachments equal or less then
(KB).

l To change the Title of the project within Outlook simple double click on
the Project Title field in the Manage Projects window (this can be useful
if you want to add the same project more than once for different user
Ids.)

l The date from which mail/transmittals are synchronised can also be
modified by double clicking on the Synchronise From” field.
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See also:

3.1 TEAMBINDER TAB NOT VISIBLE

If the Teambinder Tab is not visible when Outlook is first opened, it is able to be installed manually.

1. Click File.

2. Select Options.

3. Click Add-ins on the left-hand bar and navigate down toManage >>Com Add-Ins. Click Go.
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4. Scroll down to Teambinder Outlook Integration and tick the check box to enable the plug in.
Click OK.
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5. The Teambinder Tab is now enabled.

3.2 OUTLOOK ADD-IN WARNINGS

If you receive an Add-In Alert from Outlook advising that your Add-In is causing Outlook to run slowly
and has been disabled, you can change the settings to Always Enable the Outlook Integration Add-In.

1. Click File from the toolbar.

2. Select theManage COM Add-ins button.

Page 20 of 45 InEight Inc.  |  Release 23.12

3.2 Outlook Add-In Warnings Outlook Integration User Guide



3. Click Options to expand. Click the Always enable this add-in radio button, click Apply.
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4. A new set of options will be provided, select Do not monitor this Add-in for the next 30 days.
Click Apply and Close.
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CHAPTER 3 — CREATING NEW INEIGHT
DOCUMENT MAIL

From the InEight Document Tab you can manage all the normal InEight Document mail functions
within Outlook. The InEight Document registers (mail and transmittals) are displayed below the Project
folder within the InEight Document set of folders as shown below.
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1. From the InEight Document tab within Outlook click New Item or InEight Document New Item
from the Home tab.

2. Select the Project, chooseMail then select the mail type from the drop-down list. This opens the
mail compose screen as you would see it in InEight Document.
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3. To add recipient(s), select the “To” and “CC” button or begin typing contacts names and select
from suggested users.

4. Create and send mail as per normal in InEight Document.

Recipient contact details are from the InEight Document Project Address Book and not
from the Outlook Address Book.

CHAPTER 3 — MANAGING MAIL WITHIN
OUTLOOK
1. To open Outlook Integration mail with the same formatting and fields available as in InEight

Document, select the mail in the register and click the Open Item in InEight Document button.
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2. To reply to an InEight Document mail when opened from the Open Item in InEight Document
tab, click the Reply or Reply All button. If there is more than one mail type configured for the
response, select from the list of mail types to use for your reply as normal.

3. To reply to an InEight Document mail from within Outlook, select the InEight Document mail
item you wish to respond to and open it. Then click the Reply or Reply All button. If there is
more than one mail type configured for the response, select from the list of mail types to use for
your reply as normal.

See also:
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3.1 CHANGE MAIL STATUS

1. To change the Status of a Mail: Select mail item(s) from the appropriate inbox and then click the
Change Mail Status button from the InEight Document tab and update as required.

2. To do a Send and Receive refresh between Outlook and InEight Document click the Send/
Receive All button.
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CHAPTER 4 — OFFLINE ACCESS AND MAIL
CREATION

If there is no internet connectivity or Outlook is in offline mode, new mail cannot be sent or received
from InEight Document. However, existing mail already synchronized with Outlook can be accessed
and offline drafts created (although not with the InEight Document specific fields) and stored in an
offline folder. This draft is then sent through InEight Document once connectivity is regained and after
the final draft is completed.

For more information, see the link below.

4.1 Drafting mail offline 29

4.1 DRAFTING MAIL OFFLINE

1. SelectWork Offlinemode from the Send/Receive tab.

2. Click on the New Mail button.
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3. Select a Mail type from the list. You will receive the following message, select Yes.

4. Add the relevant details to the Mail.
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5. Click the Send button. An InEight Document message will be displayed, click OK.

6. A draft has now been saved in the Offline Drafts folder.
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7. Reconnect by switching theWork Offline button off again.

8. Select the Offline Drafts Folder, open the draft mail item.  
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9. You will receive the following message, click Yes.

10. As you were not connected to InEight Document when the draft mail was created, the recipient
will need to be selected. In the InEight Document Contact field, select the recipient from the
drop-down list. Click OK.
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11. The Draft will open in InEight Document, complete the relevant fields and click Send.

12. The mail is now visible in InEight Document.
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CHAPTER 5 — UNREGISTERED MAIL

Outlook mail can be dragged and dropped directly into InEight Document using the Outlook Integration
Unregistered Mail folder. Mail remains Unregistered until it is processed, (ie all mandatory fields
completed, and mail sent).

The Unregistered Mail folder appears below the Sent Items folder in Outlook and is available if users
have personal access to the unregistered mail function in InEight Document.

For users without access to the Unregistered Mailbox in InEight Document, access must be granted by
an Administrator.

For more information, see the link below.

5.1 Importing Unregistered Outlook Mail into InEight Document 35

5.1 IMPORTING UNREGISTERED OUTLOOK MAIL INTO
INEIGHT DOCUMENT

1. Drag Outlook mail to the Unregistered Mail Folder for the appropriate project.

2. Open the unregistered mail and complete all mandatory fields including the To and CC field mail
recipient(s) and Mail Type.

3. Click Send.

4. The Mail will now appear in the recipient(s) InEight Document Inbox as well as their Outlook
Integration InEight Document Inbox (if they have Outlook Integration).
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l When an offline draft is being processed into InEight Document by the
user, if recipient emails map to multiple contacts in InEight Document,
the user can choose which contact should be selected.

l Outlook Integration will NOT move the original mail item.
l The unregistered mail folder will only appear in Outlook Integration if
personal unregistered boxes are activated in InEight Document.
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CHAPTER 6 — TRANSMITTALS

From the InEight Document Tab you can manage a number of InEight Document Transmittal functions
using Outlook.

For more information, see the link below.

6.1 Creating New InEight Document Transmittals 37

6.1 CREATING NEW INEIGHT DOCUMENT
TRANSMITTALS

1. From the InEight Document tab click New Item or InEight Document New Item from the Home
tab.
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2. Select the Project, choose Transmittal then select the Transmittal type from the drop-down list.
This opens the Transmittal compose screen as you would see it in InEight Document.

3. To add recipient(s), select the “To” and “CC” buttons or begin typing contacts names and select
from suggested users.

4. Create and send Transmittal in the same way as if you were logged into InEight Document and
using the normal Transmittal screen.

l Recipient contact details are from the InEight Document Project Address
Book and not from the Outlook Address Book.

l Use the Open Item in InEight Document button to open a transmittal from
within Outlook with all the formatting and fields you would see if you were in
InEight Document.

l To manage the Synchronization of Transmittal information between InEight
Document and Outlook use the Enable Transmittals option from within the
Manage Projects window. A subfolder for Transmittals is created under the
Project folder in Outlook.
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CHAPTER 7 — REMOVING A PROJECT
1. SelectManage Projects from the InEight Document tab.

2. Tick the check box for the project you wish to remove.

3. Click Remove then OK.
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CHAPTER 8 — SETTINGS

The InEight Document Outlook Integration settings window allows the user to modify settings on a
personal basis.

See setting options below:

8.1 PROXY SETTINGS

This tab will allow you to set the proxy server settings to be used by InEight Document Outlook
Integration when connecting to the InEight Document servers.

1. Click Settings.

2. Update Proxy settings (between the user’s account and the internet) as required from the Proxy
tab.
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8.2 GENERAL SETTINGS

The following settings can be adjusted from this tab:

1. Disable Expect: 100-continue headers – Enable this option to fix connection issues between
InEight Document Outlook Integration and the InEight Document server caused by the 100-
expect-continue and keep-alive headers.

2. Mark as Unread all downloaded mails – All downloaded unregistered mails will be marked as
unread when enabled.

3. Sync Changes to downloaded mails – if this is not enabled the status changes within InEight
Document to previously downloaded mails will not be updated in Outlook.

4. Sync Response required by date from InEight Document – If ticked this will enable the
“Response Required By” date in Outlook. (This is ticked by default).
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5. Do not download mail or transmittal attachments – Does not download any attachments in
Outlook.

6. Download mail or transmittal attachments equal or less than (KB) – Will only download
attachments equal or less than a specified size.

7. Use Default Browser to Open InEight Document Items – When setting is enabled, and an
internet connection is available, items opened in InEight Document (by using “Open in InEight
Document” button) will be opened as a new window/tab in the user’s default browser.

8.3 UPDATE SETTINGS

Settings in this tab control the frequency that Outlook Integration checks for updates.This tab gives
you the following update options:

1. Never – does not allow you to update Outlook when it becomes available.

2. Each time Outlook is started – will update every time there is a new Outlook version available.
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8.4 OFFLINE DRAFTS

This tab provides the following options for inserting a signature while drafting mail offline:

1. Include no signature.

2. Use the default Outlook signature.
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3. Use an InEight Document signature associated with the InEight Document user.
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